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CLO1 Perform advanced surveying methods, including GPS, Total Station, 

and AutoCAD Land Survey, with accuracy and efficiency. 

CLO2 Interpret and analyze spatial data using ArcGIS, Mouza maps, and 

Porcha documents to support land management and civil engineering 

projects. 

CLO3 Apply modern surveying techniques to solve real-world engineering 

problems, such as site planning, infrastructure layout, and land 

boundary identification. 

CLO4 Demonstrate the ability to plan and execute surveying tasks 

independently and collaboratively, integrating traditional and digital 

tools effectively. 
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WEEK 01-02 

 

   Fieldwork No. 1  

                          Global Positioning System (GPS) 

 

 



Introduction:  

Global positioning system is a radio based navigation system used to determine exact position. It 

is a constellation of Earth orbiting satellites that can provide continuous three dimensional 

positioning 24 hours a day throughout the world. The first satellite was developed in 1960 to allow 

ships in the US Navy to navigate the oceans more accurately. GPS was originally intended for 

military applications but in the 1980 the government made the system available for civilian use. 

GPS provides location and time information in all weather anywhere on or near the earth.  

Three segments for GPS  

a) Space segment:  

Minimum of 24 satellites currently 34 in Orbit around Earth at altitude 20,000 km transmit 

radio navigation Signals, Store and retransmit the navigation message sent by the control 

segment. The orbit position is constantly monitored and updated by the ground stations each 

satellite is identified by number and broadcast a unique signal. Each satellite has 6 orbits three 

satellites work for GPS, 4th satellite work for accuracy three satellites for 2D fix satellite Orbit 

distance 20,000 km orbital speed is 14000 km per hour 60 degree apart and 55 degrees with 

respect to equatorial plane. 

 

Figure: Space Segment System 



Space segment satellite uses two types of signals to calculate distance  

1) code phase ranging  

2) carrier phase ranging 

 

Figure: Space Segment Signals 

b) Control Segment:  

The control segment of the Global Positioning System is a network of ground stations that 

monitors the shape and velocity of the satellites' orbits. The accuracy of GPS data depends on 



knowing the positions of the satellites at all times. The orbits of the satellites are sometimes 

disturbed by the interplay of the gravitational forces of the Earth and Moon. 

Monitor Stations are very precise GPS receivers installed at known locations. They record 

discrepancies between known and calculated positions caused by slight variations in satellite 

orbits. Data describing the orbits are produced at the Master Control Station at Colorado 

Springs, uploaded to the satellites, and finally broadcast as part of the GPS positioning signal. 

GPS receivers use this satellite Navigation Message data to adjust the positions they measure. 

If necessary, the Master Control Center can modify satellite orbits by commands transmitted 

via the control segment's ground antennas. 

 

Figure: The Control Segment of the Global Position System 

 

c) User Segment:  

GPS receiver collects and processes signals from the GPS satellites use that information to 

determine and display the location, speed, time and so on. The accuracy and reliability is 

enhanced as the number of visible satellites increases. The typical receiver is composed of an 

antenna and preamplifier radio signal microprocessor control and display. Data recording unit 

and power supply records the timing signals from the visible satellites calculating their 

distances latitude-longitude elevation and time. Their position is updated on a second by 

second basis output to the receiver display device and stored by the receiver Logging unit. 

 

 

 



Instruments: 

1) Antenna and cables  

2) Batteries and power cables 

3) Tripods, adapters  

4) Tape measures  

5) Flashlights  

6) Radios  

7) Station log sheets  

8) Writing apparatus (pens)  

9) Station descriptions  

10) Observing schedule and station lists  

11) Traffic cones, safety equipment  

12) Maps, keys, lock combinations. 

 

Working Procedure: 

The working of a global positioning system can be divided into three main parts, namely a 

ground station, a network of satellites, and a receiver. 

1. Ground Stations  

The ground stations of a global positioning system typically make use of multiple RADARs to 

monitor the position and the condition of the satellites present in outer space. The satellites 

tend to move in a fixed circular path around the earth and are susceptible to frequent wear and 

tear. The ground stations help to keep a check on the health of the satellites. The working of a 

global positioning system to detect the location of a particular object or place primarily 

depends on the position of the satellites, which is why the information regarding the position, 

distance, location, and health of a satellite is required to be processed and maintained by the 

RADARs available at the ground stations at every instant of time. 

 

2. Satellites 

A global positioning system typically comprises a network of 32 satellites orbiting the earth. 

24 out of the 32 satellites are the core satellites; whereas, the remaining 8 are known as the 

emergency satellites. The emergency satellites are reserved to be used in case a malfunction or 

failure occurs in any of the core satellites. The average life span of a satellite is about 10 years. 

The satellites receive the signal broadcasted by the ground stations and transmit it back to the 

earth after processing. 

 



3. Receiver 

The receiver element of a global positioning system is nothing but the GPS chip that is present 

within the gadgets that we use in our daily life. This means that the mobile phones that we use, 

the smartwatches that we wear, and the navigation system installed in our vehicles serve to be 

the receiver and an integral part of the global positioning system. The receiver devices 

continuously receive signals from the satellites and help calculate the distance between the 

receiver devices and the network of satellites. The distance estimated with the help of four or 

more satellites present in outer space helps locate the exact position of an object, a device, or 

a person. 

The working of a global positioning system involves simple steps. The first step involves the 

continuous transmission of the signal from the satellite to the GPS receiver. This transmission 

signal contains information regarding the current position of the satellite and the current time. 

The position of the satellite can be determined easily as the satellites tend to move in a fixed 

orbit. The signal that is received by the receiver devices is then processed and analysed. The 

main objective is to estimate the location of at least three satellites present in outer space and 

the distance of the receiver device from those satellites. Since the speed with which the signal 

travels between the satellite and the receiver is equal to the speed of light and the time taken 

by the signal to travel from space to earth and vice versa is noted with the help of a timing 

circuit, the calculation of distance can be done easily with the help of the speed and distance 

formula. The timing circuits used by some of the global positioning systems make use of 

atomic clocks; however, they can not be used for each and every GPS application due to the 

high cost. One of the prime concerns of using the satellites present in outer space to estimate 

the location of the objects present on the surface of the earth and to determine the current time 

is the relative nature of time. The relativity of time means that time tends to move faster for 

the objects that are present in outer space with respect to the objects that are present in the 

earth’s atmosphere. This problem can be resolved easily by fetching signals from more than 

three satellites and processing the information extracted from the data received by all of them. 

This helps reduce the chances of miscalculation and misinterpretation of data by the receiver 

devices. 

 

Applications of GPS system in civil engineering 

The Global Positioning System (GPS) has gained massive popularity in many industries. Civil 

Engineering is one of the industries that largely rely on GPS data. Besides it often involves 

working in an unfriendly and complex environment that makes it for engineers to work 

smoothly. However, GPS provides real-time and accurate data hence boosting their 

productivity even in these harsh conditions. 



Fleet management, earthmoving, and road construction largely depend on GPS devices for 

centimetre-level accuracy. Wireless communication is integrated on these devices to help GPS 

gather accurate data. 

1. Environmental monitoring 

Civil engineers monitor the environment keenly before setting up a project. This is because the 

environment can impact the project positively or negatively. Also, in the efforts to reduce 

environmental pollution, the government uses GPS to monitor pollution. Civil engineers have 

to make sure that the project can fit in the provided location before commencing with the 

project. 

2. Land seismic surveying 

Oil and gas exploration largely depends on GPS data. For example, civil engineers have to 

carry out subsurface geology first to identify the perfect spot to drill. Also, Marine seismic 

surveying can be applied by civil engineers as they seek to study the composition of the 

subsurface rocks. This is done by sending low-frequency acoustic energy below the subsurface 

rocks. Both land and marine seismic is falling under the same category of seismic engineering. 

3. Deployment of equipment/ machines 

Civil engineering usually incorporates large projects that rely on machines. The supervisors 

use GPS to track the location of these machines. Also, the can deploy the equipment to different 

sites. 

4. Road transportation 

Since there are high numbers of GPS receivers that are sold globally, the applications in road 

transportation are by the majority of the users of GPS. These applications can be for tracking 

of freight, commercial fleet management, public transport monitoring, services of a taxi, 

navigation and dispatch, emergency vehicle location and passenger information. The owners 

of private cars are also widely adopting the in-built GPS system in their cars and most of the 

manufacturers of the automobiles are into releasing newer vehicles that have an optional fitted 

GPS. 

5. Rail and Shipping Transport 

It is not to a surprise that both railways and shipping transport make use of GPS navigation 

widely. These applications include inshore and ocean navigation, approaching ports, dredging, 

docking and harbor entrance, AIS or Automation Identification System, VTS or Vessel Traffic 

Services, handling of cargo and hydrography.  

 



 

WEEK 03-04 
 

Fieldwork No. 2 

                                      TOTAL STATION 

 

 



Introduction: 

A total station is an optical instrument used in modern surveying and archaeology as well as 

by Police Crime scene Investigators, private accident investigators and insurance companies 

to take measurements of scenes. it is a combination of an electronic Theodolite light an 

electronic distance metre (EDM) and software running on an external computer known as a 

data collector. 

Beginning in about 1980 an EDM component which also had been improved to enable 

automatic readout was combined with an electronic theodolite to create a single instrument 

called the total station. 

The functions of the distance and angle measuring components were controlled by an interface 

computer. Modern total station instruments can now make slope distance measurements, 

automatically display the results and also store the data in the Computer memory. 

Components of a Total Station 

Total Station is a compact instrument which weighs around 50 N to 55 N. It consists of a 

distance measuring instrument (EDM), an angle measuring instrument (Theodolite) and a 

simple microprocessor. The components used in Total station surveying are as follows: 

1. A tripod is used to hold the total station  

2. An electronic notebook used to record, calculate and even manipulate the field data  

3. Prism and prism pole which can measure lengths up to 2 km and up to 6-7 km can be 

measured with triple prism  

4. Batteries and Chargers  

5. Data and Power cables  

6. Tribraches 

 

 



 
Figure: Basic Components of a Total Station 

 

 

Working Procedures: 

 

Leveling the Total Station 

 

1. Leveling the Total Station must be accomplished to sufficient accuracy otherwise the 

instrument will not report results.  

2. Leveling the instrument takes 30 to 45 minutes – make sure you can see all targets from the 

instrument station before going through the process 

 



Tripod Setup 

 

1. Tripod legs should be equally spaced  

2. Tripod head should be approximately level  

3. Head should be directly over survey point  

4. Mount Instrument on Tripod  

5. Place Instrument on Tripod  

6. Secure with centering screw while bracing the instrument with the other hand  

7. Insert battery in instrument before leveling 

 

Focus on Survey Point 

 

1. Focus the optical plummet on the survey point.  

2. Leveling the Instrument  

3. Adjust the leveling foot screws to center the survey point in the optical plummet reticle  

4. Center the bubble in the circular level by adjusting the tripod legs 

 

Leveling 

 

1. Loosen the horizontal clamp and turn instrument until plate level is parallel to 2 of the 

leveling foot screws.  

2. Center the bubble using the leveling screws- the bubble moves toward the screw that is 

turned clockwise  Rotate the instrument 90 degrees and level using the 3rd leveling screw  

3. Observe the survey point in the optical plummet and center the point by loosening the 

centering screw and sliding the entire instrument  

4. After re-tightening the centering screw check to make sure the plate level bubble is level in 

several directions 

 

Electronically Verify Leveling 

 

1. Turn on the instrument by pressing and holding the “on” button (you should hear an audible 

beep)  

2. The opening screen will be the “MEAS” screen. Select the [Tilt] function  Adjust the foot 

level screws to exactly center the electronic “bubble”  

3. Rotate the instrument 90 degrees and repeat. 

 

Adjust Image & Reticle Focus 

1. Release the horizontal & vertical clamps and point telescope to a featureless light 

background 

2. Adjust the reticle (i.e. cross-hair) focus adjustment until reticle image is sharply focused 



3. Point telescope to target and adjust the focus ring until target is focused  

4. Move your head from side-to-side to test for image shift (i.e. parallax). Repeat the reticle 

focus step if parallax is significant  

5. When the instrument operator changes the reticle focus may need to be adjusted 

 

 

Calibrating the Instrument 

Calibration must be completed before coordinates can be obtained 

 

3 possible calibrations: 

 

1. Backsight by angle: must know instrument coordinates and have a landmark/target at a 

known azimuth  

2. Backsight by coordinate: must know instrument coordinates and have mirror target set on a 

position of known coordinates  

3. Resection (triangulation): must have 3 or more mirror targets established at known 3D 

coordinates 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

WEEK 05-06 
 

   Fieldwork No. 3  

                          Introduction to ArcGIS 

 

 

 

 



Lab 1. Introduction to ArcGIS  
  

Purpose: To introduce you to map composition and printing in ArcGIS  

  

To Do and Hand In:  Compose, print, and hand in two maps, described below.  Maps due in lab 

one week after assignment.  

  

Data Source:  S:\GEY430_630_Spr04\avintro  

  

File Structures in ArcGIS   

 

ArcGIS is a PC windows-based GIS program developed by ESRI. It is the most widely-used GIS 

software in the world. ESRI data are often stored in “shapefiles”.  Both the geometry and attributes 

of the cartographic objects are stored in these shape files.  When you display, edit, save, or copy 

spatial data in ArcGIS, you are often working with and modifying shape files.  There are usually 

three shape files associated with a feature layer, one for the geometry (with a .shp file extension, 

for example, lakes.shp), one with a .dbf file extension for tables (e.g., lakes.dbf), and one with a 

.shx extension, for housekeeping data.  These files typically need to be in the same directory, and 

moved about together, as all three files are required to view and operate on the data.  

  

ESRI also stores data for feature layers in ArcGIS as “coverages”.  A coverage is a collection of 

files in a subdirectory.  These files contain both the graphic (location and shape data) and tabular 

(text, numbers, or other data) for variables of interest.  

  

For example, in a coverage sub-directory named stream_st, I would have a number of files, e.g., a 

file named ARC, a file named ARF, a BND, etc. There are typically approximately nine files 

which will be in all coverages, although additional files and names of files would depend on the 

type of data.   In a later lab we will go over the names and purpose for each file in the coverage; 

for now, don't worry about them.    

  

Note that a shapefile and a coverage can have the same main file name, because the coverage is a 

subdirectory and not a single file, and the shapefiles have a common name, but different 

extensions, .shp, .shx, and .dbf . You can be fooled by this because some file browsing tools (like 

Windows Explorer) won’t show the extension in some modes.  

  

ESRI software stores data with both geographic elements, and tabular (or database) elements.   

Vector geographic elements are referred to as point, line (or arc), and polygon (for area) features.  

Raster geographic elements are referred to as cells, and are stored in “grids”. ESRI by convention 

refers to grids and vector data as coverages for use with their ArcGIS Workstation product.  

Shapefiles and grids are used primarily with ArcGIS Desktop and related products.  These 

coverages, grids, and shapefiles may be thought of as layers which represent point features (for 

example, well locations), line features (streams or roads), or polygon features (counties, wetlands, 

etc.).   

  



We’ll be working with ArcGIS in this course.  ArcGIS is installed on the Windows XP machines 

in our lab.    

  

Creating Your Working Directories  

Before we begin, you should know how to create or move to working directories for yourself.   

Perhaps the easiest method is through the Windows Explorer tools.  Open Windows Explorer  

(see the back of this lab for more help, and then ask us as needed).  You navigate the file/folder 

tree in the left pane, and display the contents in the right.  By double clicking on a folder, you 

move to that level, “opening” it.  Notice that a single click highlights the folder in blue, a double 

click opens it.  You should copy all the files from S:\GEY430_630_Spr04 to your area.  If you do 

not know how to do this, read the instructions at the back of this lab, and/or consult with the lab 

instructor.  Everyone should read the notes on copying coverage files using Windows Explorer at the 

back of this lab.  

  

It is important you copy the lab data to your area (H:drive the lab computers) and work in your 

area.  All your work will then be saved there. From now on, we will refer to the drive that contains 

your working dataset as your DATADRIVE.  For example, if the student drive on the lab computer 

is H:\ and we wish to work in the directory H:\avintro, I will refer to it as the directory 

DATADRIVE:\avintro.    

  

You also may want to have backups, particularly for later labs, where the work is more involved.  

In our lab the ZIPDRIVE is D:\  and the writeable hard drive is H:\.   Please save your data in two 

places, e.g., on the lab computer’s harddrive and one ZIP disk, or on a second ZIP disk.  

  

Starting ArcGIS  

To start ArcGIS, click the start menu and select  Programs > ArcGIS > ArcMAP,   

  

leftclick on the ArcMAP icon,     (the magnifying glass with the world inside).  

  

BE PATIENT WHEN WAITING FOR ARCGIS TO START…IT MAY TAKE UP TO 10- 

15 seconds, depending on what else is running.   If you click multiple times, you’ll get multiple 

copies running, which will slow all copies down.  After some rumblings, you will get an 

ArcMAP window.   



 

 

Click on the 

Plus sign   

    
to add data 

layers  
 

You will get a question, asking if you wish to create a new map or open an existing one.   If you 

get these questions, answer OK to the New Empty Map request  

  

You should have a panel that looks similar to the one below.  

  

 
  

  

  
  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  



Displaying Shapefiles in ArcMap  

Within ArcMap groups of data are organized into DATA FRAMES.  A DATA FRAME layer 

view consists of themes that you wish to display.  ESRI uses the word “theme” to denote one data 

layer, regardless of whether it is a shapefile, grid, coverage or other format.  “Data Layer” and 

“Theme” are interchangeable, and both will be used throughout this course. Inside a Frame you 

may specify the layers to show, titles, map symbols, types of features, and order of display.  The 

layer you choose should be automatically highlight when you enter ArcGIS.  The layer that is 

active will have a color bar around it.   

  

 
  

Click to connect to folder button.  Navigate the directory tree, clicking up and down, until you can 

see your DATADRIVE:\avintro directory and leftclick there.    

Now, double click the shapefile named ROADS.shp.  This will add this data layer to your map.    

  

• A checkbox will appear in the layer window, in the vertical greybar on the left side.  Single 

leftclick on the small checkbox next to the coverage name roads.  You should see the road 

lines disappear.  Click the roads layer off and on.  See how it works.  

  

Select the ROADS.shp with a Left click and then one Right click to bring up the context menu; 

select Remove.  Select Edit > undo to bring the roads back.   

Define Units  

For each Data Frame you will need to define the units (are the coordinates in inches, feet, meters, 

miles?).  This step has two parts (1) the coordinates of the data we are using and (2) the coordinate 

systems we wish to see on the screen.  For example, for a layer with units in meters you may wish 

to see distances in feet on the screen.  Any distance or area measurements are converted “on the 

fly” and displayed on the screen. The original units are unchanged.  

• Right Click on the Data Frame (not on an individual theme)  

  

 

  

• Select PROPERTIES, and click on the General tab  

To add data layers to the map click on the    

  



 
ADD Lakes to the Map  

Now display a lakes theme from the lakes.shp shapefile, it should be in the  

DATADRIVE:\avintro directory.  You should now have both roads and lakes on the map.  Zoom 

into the contiguous U. S.  

  

  

Changing the Legend  

You may need to reset the colors or line symbols, either to view it better or when producing a 

printed map, as we will be printing on a black and white printer.  Colors and symbols are set in 

the legend.  

  

• Double-click on a layer picture, below the name of the layer.  This will pop up the 

Symbol Editor.  Select an option that makes sense, arterial roads.  Try different options.  

Notice you can change the color and width of the line at this point.  After changing options, 

you need to select the OK button on the lower right to apply your changes.  

• Try selecting different colors, line weights, etc., for both the lakes.shp and 

roads.shp layers.  .   

  

Unfortunately, programs/operating systems can be idiosyncratic, and will sometimes crash.  It is 

a good idea to save your work now (you should save early and often).  Go to the File-Save As 

option, and make sure you are saving it to your area.   Note the default name of a project is 

blank.  You should change the name to something more meaningful to you, and make sure you 

know where it is getting saved.  

  

Your map should look something like the graphic below.  

  

  

Select  Miles  for the Display units  

  

  

  

  

  

  

  

  

  



 
  

Data frames are used for processing. Layouts are used to make maps by displaying themes along 

with text, legends, north arrows, and other information.  

 

Now you are ready  

to Print  

  

Click on the Print  

Layout button to  

prepare you map for  

printing.    

  

  

  

  

  

The  Globe  button  

moves you back to  

the working Data  

Frame.  The  Paper  

button is where you  

set up printing.  The  

Circling Arrows   

button refreshes  

( repaints) the screen  

  

  

Select the Insert Menu.    

  

Select the Title  

  

The title appears on the page.  Type in a logical title,  

such as “U. S. Lakes and Roads”.    

  



 
  

Now lets add a North Arrow.   

   

• First, use the Insert Menu to select the North Arrow.    

• Pick one you like.  

• Select OK  

• The North Arrow is put on the page with a box around it.  Dragging it to where 

you want it or increase the resize it by dragging a corner.  

  

  

Add a scale bar as you did a north arrow.  

  

Add a legend as you did the north arrow.    

  

As you add the legend you get asked several question about number of columns, boxes, style, etc   

  

Notice that the names above the legend boxes are the coverage or shapefile name.  Often these 

aren’t what we’d like.  You can modify these names in the view before you create a legend in 

the layout.  Do this by:  

• Right click on the layers.  

• Select Properties  

• From the General Tab change the Layer Name  

• Select OK  

  

You should do this for each layer you display, so that the legend will provide useful 

information.  

  

For now we will not change any thing in the legend.  Just select Next and then Finish for the 

questions. The Legend appears on the page.  Move it with to where you want it to appear (just like 

moving or resizing the North Arrow).  

  

  

Finally add text to the Page with your name and date.  

  

  

  

After the title is entered move you cursor to the title and left click to  

select the title (it will have a blue box around it) then right click to  

bring up the “Properties of the Title” window.   

  

Here you can make other changes; for example Change Symbol is the  

button to use for increasing the text size or changing fonts.    

  

    



Once you have type in your text, left click on the Text.  This will bring up a menu select 

Properties.  Use Change Symbol to increase the font, perhaps to 18.  Select OK then Apply 

and OK.  

  

Move the text to a logical place on the page.  

  

Now, once we have the theme and 

layout, we wish to save the map and 

print it.  Save the project in the main  

ArcGIS window menu, under the FILE 

> SAVE AS option.  Save in your area.  

Create a file name that makes sense to 

you.  Lab 1 Assignment 1, might be 

nice.  

  

To Print the Map, use the FILE >  

PRINT  or the printer icon button  

  

Make sure you are printing the “Print 

Layout ” Page.  You can print the 

“Data” Map but will not get the Title, 

North Arrow, etc.   

  

You may choose from several printer 

options.  After selecting the 

appropriate printer, and selecting OK 

to leave the setup screen, all further 

printing should be directed to that 

printer.  

  

  

  

Create a second map, File > New (or use the New Map 

button)  

  

  

  

  

Use the 

DATADRIVE:\avintro\Aussie_Geology\geolpldd.shp as the layer to 

display.  This is a map of the Geology of Australia.    

  

It should look like below  

  

  



  

After adding the data, Right click on the name of the layer (geolpldd) and select Properties.  At 

the General Tab change the Name of the Layer to Geology of Australia.  Then select the 

Symbology Tab.   In the upper left select Categories then Unique Values.    

  

  

Then select LITH_ASSOC using the 

down arrow next to the Value Field.  

Then click on the Add All Values.  All 

the geology types will now be shown on 

the map.  Uncheck the box to the Left of  

(all other values)  

  

Change the color scheme for the map.  

We’ll be printing on a black-and-white 

printer, so we’ll need to change the fill 

colors appropriately.    

  

Also, we’ll try to set things up to use less 

ink, and print faster.  Select a Black  

and White Color Scheme. Since the sedimentary rock value is such a large part of the map let’s 

make it blank to make the map more read able.    

  

• Left click twice quickly on the color box to the left of the sedimentary rock value.  

• Select Hollow and then OK  

• Finally, Select Apply and then OK    

  

As before switch to the Print Layout view and add Title, legend, Scale Bar, North Arrow and your 

name/date.  Practice selecting the map, title, legend and resizing each item.  Move these objects 

around into a pleasing arrangement.     

  

  

  

  

  

Your map should look something like below:  

  

  



Save this map.  File > Save As in your area.  The 

map file includes only the directions on what 

and how to display your various themes, 

layouts, etc. The .mxd file doesn’t include the 

data.  It contains pointers to where the feature 

(layer) data resides on disk.  If you move to a 

new computer, the data may not be there, and 

when you try to load the project, ArcGIS will 

ask you where the data reside.  If you work off 

of your area you shouldn’t have to worry at all 

about this, as the .mxd files and data are all 

contained that area.  However if you wish to 

copy them elsewhere, for example as backups, 

you have to save your feature data as well as the 

.mxd file to a diskette if you have created or 

modified any layers.  Remember, if you are 

saving shapefiles, you must save all three for a 

feature layer (the .shp, the .dbf and the .shx file) 

into the same directory.  

  

  

  

  

To Turn In:  

Turn in two maps, the first with roads and lakes, the second with reclassified geology.  

Remember to include the following on these and all your future maps: 1) a title, including a 

description of the map and your name, 2) a north arrow, 3 scale bar, and 4) a legend.  Points will 

be deducted if you don’t have all these elements.  

  

  

  

  

  

  
 

 

 

 

 

 

 

 

 

  



USING MICROSOFT EXPLORER TO NAVIGATE DIRECTORIES AND COPY FILES  

  

This is the MicroSoft Windows Explorer window, available from START > PROGRAMS >  
ACCESSORIES > WINDOWS EXPLORER.  You will use this file manager every lab session to click  

click on the GEY430_630_Spr04 folder, and continuously holding the mouse button down, drag it to the 

right window pane. The files should be copied. 

 

 

IMPORTANT NOTE: you CANNOT copy coverage directories by themselves and expect them to 

work; Arc/Info coverages store some data in the coverage directory, and some in an associated INFO 

directory at the same level in the directory structure.  You need to copy the entire directory structure one 

level up.  

  

  

  

  

  



  

 

 

 

ArcGIS Buttons & Menus  

  

  

 
  
Note:  ArcGIS Menu and Buttons are all “customizeable”, meaning you can move them anywhere on the screen. 

You can also turn groups of buttons on an off with the Tools Menu by Selecting the Customize Submenu.   

  
For our class we have elected to “lock the menus”.  This allows instruction and handouts easier to be consistent 

with your display.    

  

 
Open Existing   Copy  
Save      Paste  
Print      Delete  

  

  

 
 

 

 

                  The left side of the Menu  

  
Scale  Add Layer    Cut    New Map  ( select a scale or enter a value )   

                  The right side of the Menu  
  
   

  

  

  

  

  

  

  



 

WEEK 07-08 
 

   Fieldwork No. 4  

                                      Porcha 

 

 



Introduction 

Porcha, also known as a Record of Rights (ROR), is a vital legal document that reflects the 

ownership and details of a parcel of land. It serves as evidence in property disputes, helps in land 

transactions, and ensures the rightful ownership of the land. This lab manual provides a step-by-

step guide to understanding and preparing a Porcha. 

 

Objectives 

To understand the components of a Porcha. 

To learn the process of gathering land-related data. 

To practice documenting land ownership and measurement details accurately. 

To familiarize with the official forms and formats used in Porcha preparation. 

 

Materials Required 

Survey maps and records 

Measuring tapes and survey instruments 

Land ownership documents (deeds, khatians, mutation papers) 

Official forms for Porcha 

Computer with document preparation software 

Printer and scanner 

 

 

 

 



Steps for Preparing Porcha 

 

Step 1: Collect Preliminary Information 

• Obtain the plot number, khatian number, and relevant details from the landowner. 

• Collect previous Porcha copies and related legal documents, such as sale deeds and 

mutation records. 

• Verify the plot's classification (residential, agricultural, commercial, etc.). 

 

Step 2: Survey the Land 

• Conduct a detailed survey of the land using chain surveying or plane table methods. 

• Record measurements and identify landmarks, boundaries, and adjacent plots. 

• Prepare a sketch or map showing the land layout. 

 

Step 3: Verify Records 

• Cross-check collected data with official land records maintained at the local land office 

or union parishad. 

• Ensure there are no discrepancies in ownership, boundaries, or classification. 

 

Step 4: Document Preparation 

• Draft the Porcha using the official format. Include: 

• Owner’s name and address 

• Plot and khatian numbers 

• Area and boundaries of the land 

• Land classification 

• Encumbrance or mortgage details (if any) 

 

 



Step 5: Review and Authentication 

• Review the drafted Porcha for accuracy and completeness. 

• Obtain authentication from the local land office or authorized official. 

 

Step 6: Final Documentation 

• Print and sign the finalized Porcha. 

• Provide copies to the landowner and retain a record for future reference. 

 

 

Figure: Porcha 

 

Precautions and Best Practices 

Accuracy: Ensure all measurements and details match official records to avoid disputes. 

Clarity: Use clear language and unambiguous descriptions. 



Verification: Regularly update and cross-check records with the local land office. 

Security: Store Porcha and related documents securely to prevent damage or loss. 

 

Frequently Asked Questions 

1. What is the validity of a Porcha? 

Answer: Porcha remains valid unless there are changes in ownership or other legal aspects. 

2. Who can issue a Porcha? 

Answer: It is issued by authorized officials at the land office. 

3. What if there is an error in the Porcha? 

Answer: Contact the local land office to initiate a correction process. 

 

Conclusion 

Preparing a Porcha is an essential skill for land management and property documentation. By 

following this manual, students can gain hands-on experience in creating accurate and legally 

valid records of land ownership. 

 

 

 

 

 

 

 



 

 

WEEK 09-10 

  Fieldwork No. 5 

                             MOUZA MAPS 

 

 

 

 



Introduction 

A Mouza map is a detailed cadastral map that delineates individual plots within a mouza (village 

or locality). It is an essential tool for land administration in Bangladesh, aiding in property 

ownership verification, land-use planning, and dispute resolution. This lab manual outlines the 

procedure for preparing and interpreting a Mouza map, tailored to the Bangladeshi context. 

 

Objectives 

• To understand the components and significance of a Mouza map. 

• To learn the process of surveying and mapping land parcels within a mouza. 

• To practice preparing and analyzing Mouza maps for land management. 

• To adhere to official standards and formats used in Bangladesh for Mouza mapping. 

 

Materials Required 

• Existing cadastral records and Mouza maps 

• Survey instruments (e.g., total station, theodolite, plane table, measuring tapes) 

• Official Mouza map templates 

• Graph paper or GIS/mapping software 

• Reference documents (e.g., ROR, khatians, mutation papers) 

• Printer and scanner 

 

Steps for Preparing a Mouza Map 

Step 1: Gather Preliminary Data 

• Obtain the latest Mouza map and cadastral survey records from the local land office. 

• Collect information on plot numbers, khatian numbers, and land classifications. 

• Identify landmarks and adjacent mouzas for reference. 

 

 



Step 2: Conduct a Field Survey 

• Visit the mouza and conduct a comprehensive survey using total stations, theodolites, or 

plane tables. 

• Record accurate measurements of plot boundaries, natural features, and infrastructure 

(e.g., roads, canals). 

• Note any changes or discrepancies from existing records. 

 

Step 3: Plot the Data 

• Plot the surveyed data onto graph paper or digital mapping software. 

• Ensure the map includes a clear scale, north arrow, and legend. 

• Label each plot with its respective number, dimensions, and area. 

 

Step 4: Verify and Cross-Check 

• Cross-check the drafted Mouza map with official records for consistency. 

• Validate plot ownership and boundaries by consulting local landowners and officials. 

• Resolve discrepancies by revisiting the site if necessary. 

 

Step 5: Finalize the Map 

• Prepare the finalized Mouza map using official symbols and standardized formatting. 

• Include necessary details such as landmarks, natural features, and plot boundaries. 

• Obtain verification and authentication from the local land office. 

 

Step 6: Documentation and Distribution 

• Print and distribute authenticated copies of the Mouza map to stakeholders (e.g., 

landowners, local authorities). 

• Retain a digital backup for future updates and reference. 

 

 



Precautions and Best Practices 

Accuracy: Ensure precise measurements to avoid future disputes. 

Standardization: Use official symbols, legends, and scales approved by the Bangladesh land 

administration. 

Community Involvement: Engage local stakeholders to ensure accuracy and address concerns 

during the survey. 

Data Security: Securely store survey records and maps to prevent loss or unauthorized alterations. 

 

Frequently Asked Questions 

1. What is the standard scale for a Mouza map in Bangladesh? 

Typically, Mouza maps use a scale of 16 inches to 1 mile, but local variations may apply. 

2. Who is responsible for preparing Mouza maps? 

Mouza maps are prepared by the government’s survey department or licensed surveyors. 

3. How often should a Mouza map be updated? 

It is recommended to update Mouza maps periodically, especially after significant changes in 

land ownership or use. 

 

Conclusion 

Preparing a Mouza map is an integral part of land management and administration in Bangladesh. 

This manual provides a systematic approach to creating accurate and legally compliant Mouza 

maps, ensuring students are well-prepared for professional land surveying roles. 

 

 

 



 

 

WEEK 11-12 

  Fieldwork No. 6 

                    AutoCAD LAND SURVEY 

 



Introduction 

AutoCAD is a powerful tool for land survey and drafting that allows for precise mapping, analysis, 

and documentation. This lab manual provides a step-by-step guide to performing land surveys and 

drafting them using AutoCAD. The focus is on integrating survey data into AutoCAD for accurate 

land parcel mapping and professional presentation. 

 

Objectives 

• To understand the basics of AutoCAD for land survey applications. 

• To learn how to import and work with survey data in AutoCAD. 

• To create and modify land parcel drawings using AutoCAD tools. 

• To generate professional-quality maps and layouts. 

 

Materials Required 

• Computer with AutoCAD software installed 

• Survey data (coordinates, distances, angles) 

• Total station or GPS equipment 

• Digital storage device (USB, external hard drive) 

• Reference land maps or cadastral records 

 

Steps for AutoCAD Land Survey 

 

Step 1: Setting Up AutoCAD 

• Open AutoCAD and create a new drawing. 

• Set the drawing units (e.g., meters, feet) and ensure the workspace is suitable for drafting 

(e.g., "Drafting and Annotation"). 

• Save the file with an appropriate name. 



 

Figure: Setting up AutoCAD 

Step 2: Importing Survey Data 

• Collect survey data in a format compatible with AutoCAD (e.g., CSV, DXF). 
• Use the "Import" function or external plugins to bring survey data into AutoCAD. 

• Verify that all points, lines, and features are correctly imported. 

 

Figure: Importing Survey Data 



 

Step 3: Drafting Land Parcels 

• Use tools such as "Line," "Polyline," and "Arc" to draw land boundaries based on survey 

data. 

• Apply snapping tools for precise alignment and connections. 

• Label plots with plot numbers, dimensions, and area using the "Text" and "Dimension" 

tools. 

 

Figure: Drafting Land Parcels 

Step 4: Modifying and Annotating the Map 

• Edit boundaries, add additional features (e.g., roads, landmarks) as needed. 

• Use layers to differentiate between various elements like roads, plots, and landmarks. 

• Annotate the map with north arrows, scales, and legends for clarity. 

 

Step 5: Creating a Layout 

• Switch to the "Layout" tab to prepare the map for printing. 

• Insert a title block and include project details such as the map title, date, and scale. 

• Adjust the viewport to fit the map within the layout space. 



 

Figure: Creating a layout 

 

Step 6: Finalizing and Printing 

• Review the drawing for errors or missing elements. 

• Plot the drawing using a suitable plotter or export it as a PDF for digital use. 

• Save the final version in DWG format for further edits and backup. 

 

Precautions and Best Practices 

Data Accuracy: Ensure that survey data is accurate and complete before importing into 

AutoCAD. 

Layer Management: Use distinct layers for different elements to maintain clarity and 

organization. 

Backup Files: Save copies of your work frequently to avoid data loss. 

Professional Standards: Follow standard conventions for scales, symbols, and annotations. 

 

 



Conclusion 

Using AutoCAD for land surveys streamlines the process of drafting, analyzing, and presenting 

land-related data. This manual equips students with practical skills to create professional land maps 

and supports efficient land management practices. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

WEEK 15-16 
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WEEK 17 
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